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Welcome to SCaN's first real attempt at a
newsletter.  We hope you find it worthwhile and
will feel free to make suggestions or requests.
Inside you'll find some comments on 2.0, a review
of TouchType by our invaluable secretary and
newsletter co-editor, Lorraine Rapp, a couple of
"alerts" from NeXT, a comparison of PCs, Macs and
NeXTstations for academia and a Mathematica
tutorial, both by Dave Bradley, and many bits and
pieces of info we garnered off the net in the past
month.  

 at CSU Los Angeles, was very successful thanks to
SCaN VP Bob Desharnais and Gary Novak.  Gary is
head of the Nuggets group at CSULA, who have
done some neat things we'll discuss in a future issue.
At CSULA we saw the power of NeXTstep in demos
of Lotus' Improv, Ashton Tate's PowerStep, and
WordPerfect (which is now shipping).   
 
The third meeting was held at the CSU Northridge
Matador Bookstore (thanx Glenn Horn and staff)
where NeXTstations with 105MB disks are being
sold in the low $3000 range for people associated
with most CSUs and several junior colleges in
Southern California.  (Call CSUN at 818-885-4985
for further information. You can still get a free copy  
(continued on page 3, column 2) 
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The Southern California NeXT User's Group
emerged from a loosely based group of students,
faculty and staff at California State University Long
Beach who took my seminars and wrote NeXT
applications together in 1989-1990.  In the style of
BaNG and SNuG (Bay Area and San Diego NeXT
users' groups), I came up with the name SCaN and
invited NeXT and the outside world to a 9/27/90
meeting in Long Beach.   
 
The turnout was of 45 people was pretty good for a
first "outside" meeting.  Rick Jackson of NeXT
showed a video of highlights of the 9/18/90 Steve
Jobs unveiling of the new NeXT products in SF and
flawlessly demonstrated NeXTstep 2.0 on a 68040
NeXTstation.  The second meeting, held in October  

 INTRO TO SCaN
Mike Mahoney (mahoney@beach.csulb.edu)
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Evaporating disadvantages 
When first announced, the NeXT
had many advantages over its
competition, such as Display
PostScript, an optical drive, and
the NeXTstep Interface Builder,
which dramatically accelerates
application development. Howev-
er, they had a few disadvantages.
Sluggish performance was most
prominent. The upgrade to the
68040 processor (especially when
accompanied by 16Mbytes of
RAM) has turned the snail into a
rabbit. (The Mac only rates the
speed of a limpet on that scale).
The price was steep, compared to
PCs. Now the NeXTs are the clear
price/performance leaders (see
the systems comparison table).
They came infested with bugs in
release 0.8, but most of these have
been exterminated, and hopefully
no new ones have snuck in with
release 2.0. The other primary
complaint was lack of application
software. This situation has sub-
stantially improved. I’ll discuss
each major application area sepa-
rately: 

Word Processing & Desktop Pub-
lishing 

This is one of the NeXT’s most fa-
mous strong points. The combina-
tion of the megapixel display with
display PostScript for real time
wysiwyg, and FrameMaker soft-
ware led the Seybold report to de-
clare the NeXT to be the best
desktop publishing platform
available. Recent announcements
of additional software (such as
WordPerfect, and QuarkXpress -
a very high end publishing prod-
uct) can only enhance NeXT’s
reputation in the area. Note: This

memo was produced with FrameMaker. 

Spreadsheets 
Until recently a weakness, this is
now one of NeXT’s major advan-
tages. Several products are avail-
able (such as Wingz, and Ashton-
Tate’s PowerStep), with Lotus’
Improv receiving particular ac-
claim as the re-invention of the
spreadsheet with unprecedented
power, versatility, and ease of use. 

Database Management 
Offerings here range from inex-
pensive flatfile programs (eg.
DataPhile) to full relational SQL
based systems (Sybase, Ingres,
and Oracle). A cartographic data-
base with worldwide coastline, in-

ternational, internal, and drainage
system boundaries (MundoCart/
Optical) is also available. 

Mathematical and Statistical
Analysis 
Although currently a deficiency
area, this will soon be remedied
when SAS and Systat become
available. These are two of the
best statistical packages any-
where, with excellent graphics
support.  
I expect the NeXT version to be
far superior to the mere PC ver-
sions. In mathematical software,
the inclusion of Mathematica with
any NeXTstation sold to academ-
ic users is a major feather in the
cap for NeXT. Inclusion of TeX
also greatly aids mathematical
document preparation. 

Business Graphics 
All of the spreadsheet packages
provide extensive business graph-
ics facilities. Use of PostScript
throughout the NeXT provides for
easy incorporation of these into
desktop publishing applications.
SAS and Systat will provide more
powerful graphics tools for data  

(continued on page 3, column 1) 
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From:  Dave Bradley,  SCaN member December 1990 
    Academic Computing, CSU Long Beach, dbradley@beach.csulb.edu 
 

The NeXT as an Academic Personal Computing Platform 
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MEMO 
(continued from page 2, column 3) 

analysis. Mathematica includes
extensive 2D & 3D graphics as
well. Freehand paint style graph-
ics are included with the system. 

Graphic Design 
Display PostScript makes this an
excellent product for graphic de-
sign and artistic rendering. The
addition of color in a fully func-
tional form (with thousands of si-
multaneous colors supported by a
graphics coprocessor) exceeds the
capabilities of PCs, even when
equipped with expensive super
graphics boards. With the an-
nouncement of Adobe Illustrator,
TextArt, TopDraw, and Artisan
for the NeXT, this potential can
now begin to be realized. 

CAD 
This is one of the NeXT's weak
points in software availability.
Certainly, the rendering aspect of
CAD is well covered with Illus-
trator and Artisan, but I am as yet
unaware of any parts-design pro-
grams comparable to Autocad, or
any integrated circuit design pro-
grams available on the NeXT.
Presumably some will appear in
the future. 

CAI 
The NeXTstep application devel-
opment environment vaults the
NeXT far beyond any competitor
for simplicity of interface devel-
opment. Computer aided instruc-
tion modules that involve
simulation can combine the power
of NeXTstep with Mathematica to
cut development time by an order
of magnitude over traditional pro-
gramming. In addition, hypertext
is now available for the NeXT
with the HyperCube hypercard-
compatible hypermedia product. 

INTRO TO SCaN 
(continued from page 1, column 2) 

of  Improv  if  you order  before 3/
31/91.)  At CSUN we distributed
copies of issue 11 of the NeXT
User's Journal (a great publication
from Georgia edited by Erica
Liebman) and other information
we'd received off the Internet. 
 
At the 1/24/91 CSULB meeting
we'll see an IBM RS/6000
running NeXTstep 1.0, gain
further insight in NeXTstep 2.0
on NeXTs and distribute this
newsletter. NeXTstep 1.0 on the
RS/6000 is fast but lacks many of
the NeXT’s bundled application
software. /NextApps contains
only Interface Builder, Edit, and
Terminal. 
 
The basic goals of SCaN are to get
together people who are
interested in NeXTs, disseminate
information (newsletters in
particular), present on-line demos
and with overhead projection,
have 3rd party software and

hardware vendors demonstrate
their products, have a jolly old
time, etc.  We may also set up
special interest groups for
developers, desktop publishers,
musicians, or others should there
be a demand (let us know). 
 
A proposal I wrote in September
describing our goals was
apparently enough to convince
NeXT that we were serious (we
are!) and they presented us with a
Golden Nugget award.  The
$2500 award has and will
continue to be used mainly to pay
for mailings, copies of newsletters
and net info for users who attend
meetings, and of course
refreshments. When the money
starts running out (sometime this
year) we'll have to charge dues--
sorry. 
 
Please let us know if you have any
other ideas for meetings or would
like to contribute to the newslet-
ter. (Artists:  the dude with the
NeXT shirt could be a bit cooler.) 
 

SCaNeWS  
CONTRIBUTORS 

 
Dave Bradley 
Mike Mahoney 
Lorraine Rapp 
off the net: 
Michael Callaghan 
Lawrence Clarke 
Simson Garfinkel 
Dany Guindi 
Chuck Herrick 
Gerry Swislow 
Editors: 
Mike Mahoney & Lorraine Rapp 
 
Article submissions are encour-
aged..welcome...pleaded for! 
(contact the editors) 

Artificial Intelligence 
Allegro Lisp is available, along
with NeuExpert, a combined ex-
pert system and neural network.
Two other major products are un-
der development: Graphic
Knowledge Retrieval and NEX-
PERT. 

Color Capabilities 
Monochrome MS-DOS or Mac-
intosh systems with comparable
capabilities to the NeXT would
cost about $2,700 more than the
NeXTstation (see the comparison
table). Color can be obtained
more cheaply with PCs - in more
ways than just price. To approach  

(continued on page 8, column 1) 
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NeXT Technical Alert 90-1 
Summary 
Cannot boot after upgrading a
68030-based 2.0 machine to a
68040: Upgrade2.0 doesn't install
the 2.0 boot block. 
 
Description 
The Upgrade2.0 application in
Release 2.0 does not write the 2.0
boot block to the disk being
upgraded.  The boot block is the
first piece of code that's loaded
from the disk after you turn on the
computer; it handles the reading
of the Mach kernel from the disk
and the initial execution of Mach. 
 
The 2.0 boot block supports
68040-based NeXT computers, as
well as 68030-based NeXT
computers; the 1.0 and 1.0a boot
blocks support only 68030-based
NeXT computers.  If after running
Upgrade2.0 you then install a
68040 upgrade CPU board, the
machine will not boot.  The
symptom of this is the message: 
 
Exception 5 (0x14) 0xaddress 
 
You will see this during system
start-up (address will be replaced
by a PROM address).  The
message may be preceded by
other error messages, including
SCSI errors; these other messages
may be ignored until after
implementing the workaround,
described below.  After the
Exception message is displayed,
the system halts. 
 

Workaround 
After running Upgrade2.0, and
before you reboot, run the
Terminal application.  If you
logged in as root, omit the first
line of the following; otherwise,
type the following (plain text is
output, boldface text is what you
type; italic text will be replaced
by an appropriate value): 
 
hostname> su 
hostname# disk -b /dev/rsd0a 
disk name: diskname 
disk type: fixed_rw_scsi 
 
We recommend implementing
this workaround even if you aren't
upgrading to a 68040 now.  That
way, if you upgrade later, your
system will boot correctly after
you install your new CPU board. 
 
If you have already tried to
reboot, and got the error message
described above, put the Release
2.0 optical disk in your drive and
type: 
 
NeXT> bod 
 
at the monitor prompt.  This will
boot from the optical.  Then
perform the above steps. 
 
NeXT Technical Alert 90-2 
Summary 
Printing from NeXT computers to
printers on non-NeXT machines
doesn't work with release 2.0.  See
workaround below. 
 
Description 
The lpr program puts print jobs

into the spooling area, where they
are picked up and printed by the
UNIX printing server.  The lpr
program currently creates print
command files that are
incompatible with the standard
protocol, so a non-NeXT machine
cannot handle print jobs properly.
The symptoms are that no print
jobs to non-NeXT machines print. 
 
Workaround 
Log in to the system using your
personal account.  Run the
Terminal application and type the
following: 
 
dwrite System Printer  
 Resolution 1 
 
The above command sets the
default printer resolution to a
nonstandard value.  
 
You can now spool print jobs to
non-NeXT machines.  
 
Note: Even after applying this
workaround, you won't be able to
print to non-NeXT printers from
the PrintManager application.
Also, if you're logged in as root,
you won't be able to print to non-
NeXT printers from some
applications(for example, Digital
Librarian).  There is no
workaround for these cases. 
 
If after using this workaround you
subsequently print to a NeXT
printer, the default resolution is
reset and you cannot print to non-
NeXT hosts until you perform the
workaround again. 
 
For More Information 
Contact your organization's
support center, or NeXT
Technical Support. 

 WHAT’S UP WITH 2.0 
 “Alarming” News from NeXT 
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My impression of NeXTstep 2.0
is overall very positive.  The
Workspace Manager (WM) was
completely rewritten for 2.0 and it
alone makes it worthwhile to up-
grade.  Its File Viewer (which re-
places 1.0's Browser) contains an
area called the Shelf, which can
hold any icons of your choice.   
 
The Shelf is like the Dock but
much more useful because it can
store any type of file or folder (as
directories are now called), not
just applications.  I adjusted my
Shelf to be able to hold two
(sometimes three) rows of icons
and store .frame, .wn, and .nib
files in addition to folders (e.g.  
/NextDeveloper, ~/tmp) that I ac-
cess frequently.  About the only
time I store an application on the 
 Shelf is if it's one I'm creating - I
usually use the Dock (or even  
AltDock) for apps.  Make good
use of this time-saving resource!   

gurus won't find these too exciting
as they are simply interfaces to
the UNIX find and ps commands
which can be accessed more di-
rectly via the improved Terminal
NextApp.   
 
However, gurus will like Termi-
nal's new scrolling, copy and
paste capabilities which render
1.0's Shell NextApp obsolete.
Unfortunately, the WM shells
don't support VT100 emulation
and aren't complete login shells
(try the UNIX "who" command).
In fact, when I tried to "talk" to
another user I got the hilarious
message "You don't exist.  Go
away."!! 
 
The 2.0 user interface and its
guidelines are more consistent
and useful and are better defined.
For a simple concise overview of
them, obtain a copy of the /Nex-
tDeveloper/Examples/BusyBox
folder and "make" the BusyBox
app via a shell or Interface Build-
er (IB).  Launch it and read the
clearly stated guidelines in the
help panel.   
 
One user interface feature which
surprised me is that the same drag
event in the File Viewer will copy
or move files, depending on the
context.  I guess I'll have to get
used to this inconsistency.  (Use
Alt-drag for a sure copy.) 
(continued on page 10, column 1) 

Here are a few bugs and/or fea-
tures I have found on Release 2.0. 
(Ask_NeXT has been informed.) 
 
1)  The declaration of atof() as a
function returning a double is no
longer made if you include
<math.h>.  In release 1.0, math.h
included <stdlib.h> which con-
tained the declaration. (It took me
hours to figure out why my pro-
grams were producing funny
numbers because of this little
thing.) 

2.0
FIRST
IMPRESSIONS

 
To enlarge your Shelf first use
WM's Preferences to make your
Shelf resizable and then drag on
the Shelf's knob.  Other signifi-
cant file management advantages
of the WM are that files can be
copied or moved using only one
File Viewer and time-consuming
operations such as copying are
carried out in the background. 
 
WM's new Tools menu contains
some valuable resources for the
non-UNIX person.  You can now
find files, get a listing of the run-
ning applications and background
processes, and even activate a
UNIX shell via this menu.  UNIX

Michael K. Mahoney

 
2)  /usr/bin/less does a core dump
if you use the "E" command while
running.  The "E" command lets
you examine another file. I re-
placed this "less" with the one
from release 1.0. 
 
3)  The Icon application dies if
you tickle the menus up and
down.  This is very peculiar.   
There is probably just one sensi-
tive spot on the menus and you

OFF THE NET
Gerry Swislow
gerry @x-ray.mit.edu

just need to learn to avoid it, I sup-
pose. 
4)  You don't get core dumps un-
less you do an unlimit core com-
mand from somewhere.  I do it
from a .login file for an interactive  
(continued on page 11, column 1) 

Editors’ Note: The selection criteria for
Usenet postings are based solely on
their interest. SCaN makes no claim,
explicit or implied, as to the accuracy of
the information contained in these ex-
cerpts. We also assume that people who
post on Usenet will enjoy seeing their
words in print. 
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With the advent of high-resolu-
tion laser printers came the dream
of professional quality printed
output without the cost of a pro-
fessional typesetter, a dream
which awaited only the develop-
ment of suitable software for its
realization. As desktop publishing
and typesetting products flooded
the small computer market, how-
ever, many eager users confronted
twofold disillusionment: the soft-
ware was frequently difficult to
learn and to use, and the often
substantial disparity between an
onscreen layout and its printed
counterpart further compounded
the difficulties. 

  

The Basic Idea 
Mathematica is a tool for manipulating mathematical expressions or
formulas -- an extension of the hand calculator to higher level math.  To
use it, you just type in expressions and let Mathematica evaluate them.
A wide variety of standard mathematical functions are available for you
to use in building and operating on expressions.  Numeric results may
be obtained precisely (when rational), or to any specified degree of pre-
cision.  However, the real beauty of this system is its ability to manipu-
late symbolic expressions. 
 
When you enter Mathematica, you are placed in an empty window that
forms your workspace or notebook for the session.  As you type in ex-
pressions, and get their outputs, Mathematica keeps track of all your
work.  The entire session notebook can be saved, and recalled at a later
time. You can then continue the work from where you left off. 
 
Mathematica is sufficiently sophisticated to require a substantial time
commitment to master all of its features. It is the culmination of a tre-
mendous effort by its creator,  Stephen Wolfram.  It is absolutely essen-
tial that you have a copy of his book nearby when you try to learn this
program: 
 
Mathematica,  A System for Doing Mathematics by Computer 
Stephen Wolfram, 1988, Addison-Wesley Publishing Company, Inc.  
Redwood City, CA 

The book can be obtained at bookstores, software stores, or directly from Addison-
Wesley @(800)447-2226 

 
There is also some documentation available on the NeXT itself.  A
small portion of this material is included as an appendix to this handout.
A variety of standard notebooks illustrating the capabilities of Mathe-
matica are available on the NeXT, in the directory:  “/NextLibrary/
Mathematica/Notebooks.”  Several advanced function libraries, called
"packages," also reside in “/NextLibrary/Mathematica/Packages.” 
  
 
(continued on page 17, column 1) 

INTRODUCTION TO
MATHEMATICA
ON THE NeXT
Dave Bradley
dbradley@beach.csulb.edu

 
The NeXT's uniform use of Post-
Script to control both screen dis-
play and printer output has
enabled text processing software
developers to deliver more consis-
tently on promises of "what you
see onscreen is what you get from
the printer." Ease of use, on the
other hand, still ranges over a
wide continuum, from powerful
but somewhat daunting desktop
publishing systems like Frame-
Maker to more intuitive text pro-
cessing programs with more
limited functionality. 
 
RightBrain Software's TouchType
falls into the latter category.  
(continued on page 15) 

Lorraine Rapp

Software Review:
RightBrain
Software’s
TouchType

rapp@beach.csulb.edu
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The November release of Next- 
Answers is now available on the
Internet archive servers.  NextAn-
swers is a collection of answers to
commonly asked technical ques-
tions about the NeXT Computer
System.  The topics covered in-
clude system administration, pro-
gramming, and NeXT
applications.  When incorporated
into Digital Librarian, NextAn-
swers will supplement the exist-
ing on-line and printed
documentation, further helping
you to understand and apply the
power of the NeXT Computer. 
 
We recommend that you obtain
NextAnswers and have it installed
on the NeXT computers at your
site.  (For those of you with access
to the NeXT filesystem, NextAn-
swers will soon appear under /Lo-
calLibrary/Organization.) 
 
NextAnswers can be obtained two
ways: by ftp from an archive serv-
er, or on an OD from NeXT if you
don't have access to the Internet.
We believe you'll find NextAn-
swers an invaluable source of in-
formation!  If you have any
problems obtaining it or installing
it, contact NeXT Technical Sup-
port. 
 
If you don't have Internet access,
send an optical disk to: 
 
 NextAnswers 
 Technical Support 
 NeXT, Inc. 
 900 Chesapeake Dr. 
 Redwood City, CA 94603 

NeXT

ANSWERS
 
Inside the directory we will send
you is a file called INSTALL.wn
that contains complete instruc-
tions on how to finish the installa-
tion. 
 
If you do have Internet access,
here are the instructions for ob-
taining it from an archive server.
You can obtain NextAnswers via
anonymous ftp (file transfer pro-
tocol) from one of the following
Internet archive servers: 
 
 hostname : sonata.cc.purdue.edu 
 IP address : 128.210.15.30 
directory : pub/next/docs 
 
hostname : cs.orst.edu 
IP address : 128.193.32.1 
directory : pub/next/documents/ 
 NextAnswers 
 
There is an ftp site in Japan for our
Asian customers: 
 
hostname : etlport.etl.go.jp 
IP address : 192.31.197.99  
directory : pub/NeXT/documents/ 
 NextAnswers 
 
There are two versions of Next- 
Answers: a complete set, and a
monthly supplement for those
who already have the previous
month's complete set.  The former
is  called NextAnswers_-
Nov_90.tar.Z and occupies 415K
of disk space (1.52 Megabytes
when installed).  The latter is
called NA_Supplement_-
Nov_90.tar.Z, occupies 119K
(733K when installed), and con-
tains files that are new or changed
since the October 90 release.   
 
To obtain NextAnswers from an
archive server, su to root in a shell

and type the following com-
mands.  Replace "filename" with
"NextAnswers_Nov_90.tar.Z" or
"NA_Supplement_Nov_90.tar.Z"
depending on whether you want
the complete set or the supple-
ment. 
 
mkdirs /LocalLibrary 
 /NextAnswers 
 
cd /LocalLibrary/NextAnswers 
 
ftp hostname-or-IP-address 
  [see table above] 
 
[Login:] anonymous 
        [enter your own login name  
 as the password] 
 
ftp> cd directory 
  [see table above for the 
  directory name] 
 
ftp> binary 
 
ftp> get filename 
 
ftp> quit 
 
zcat filename  | tar -xvf  - 
 
This will create a subdirectory of
/LocalLibrary/NextAnswers
called Nov_90.  Inside Nov_90
will be a WriteNow file called IN-
STALL.wn that contains com-
plete instructions on how to finish
the installation, for both the sup-
plement and the complete set. 
 
The November NextAnswers
contain entries relating to the 1.0
software release, as well as new
ones pertaining to 2.0.  The infor 
mation below is contained in a file
called CHANGES in the untarred
directory: 
(continued on page 12, column 3) 
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MEMO 
(continued from page 3, column 1) 

the rich, high speed color features
of the NeXT, such as a 2 Megaflop
graphics coprocessor, megapixel
resolution, and 4096 simulta-
neous colors, would cost $1,900
more on a PC than on the NeXT.
Even then you would not have
some of the particularly valuable
features, such as Display Post-
Script, and transparency support. 

Sound Capabilities 
The NeXT has superb sound pro-
cessing capabilities, with its digi-
tal signal processor producing
compact disk quality sound. It has
already gathered tremendous mo-
mentum in the electronic music
world. No mere PC compares to
it. 

NeXTdimension 
This ultra high performance
graphics board leaves all the
above alternatives in the dust. It
appears sufficiently powerful to
outperform the very high end
($50,000-$100,000) graphics
workstations previously available
on the market. It includes 12-36
Megabytes of RAM, and a 33Mhz
Intel i860 risc chip that is rated at
80 Megaflops. My guess is that
this is 10-20 times the speed of the
DEC 5810, and about half the
speed of a small Cray, although it
must be seen as a idealized
throughput figure. This process-
ing power supports fully interac-
tive 32 bit color (with 16.7 million
simultaneous colors and 256 lev-
els of transparency for objects).
Since it uses Display PostScript,
you see on the screen exactly what
you would get with a hi-res color
printer. Moreover, the speed al-

lows you to drag fully rendered
objects around (not just their out-
lines). It has built-in video input
and output, and real time video
signal compression. These fea-
tures make the NeXTdimension
an outstanding hardware platform
for applications requiring high
color versatility, such as graphic
arts and design, and scientific vi-
sualization. I expect significant
software development to proceed
in this area. 

Networking 
The NeXT networking capabili-
ties far superior to ordinary PCs.
Ethernet andTCP/IP are automati-
cally included. The combined
power of NFS (Network file sys-
tem) and NIS (Network informa-
tion system) unleash the full
power of UNIX networking for
the NeXT. This allows a user to sit
down at a networked NeXT any-
where on campus, log in, and find
their files readily available. Excel-
lent electronic mail support (in-
cluding attachment of documents,
such as this FrameMaker memo)
comes for free with the NeXT
(unlike other PCs).  

Conclusions 
The NeXT provides an excellent
computer for people who want
one only to make them more pro-
ductive, and do not wish to bother
with the gory details of computer
internals. This was the primary
territory of the Macintosh, but
they match neither the price/per-
formance level, nor hardware/
software power of the NeXT. On
the other hand, the NeXT pro-
vides a software development
platform unequalled by any other
computer anywhere. The unique

features of the NeXT make it
beautifully suited for use by peo-
ple in many disciplines:  

• Humanities: Excellent text
processing facilities, com-
bined with the digital librari-
an (including the complete
works of Shakespeare on-
line), make it an ideal work-
station for these users. Math-
ematicians will find
Mathematica and TeX per-
fectly suited to their needs. 

• Fine arts: Clearly the next is a
first rate system for these us-
ers, with Display PostScript
and illustration software for
graphic artists, and fantastic
sound facilities for musi-
cians. 

• Natural and Social Sciences:
With the advent of SAS, and
Systat to supplement the oth-
er features of the NeXT, it
will become a highly attrac-
tive alternative for scientists. 

• Business: Lotus Improv leads a
collection of software (in-
cluding simulation, decision
support, and newswire analy-
sis) that will be quite enticing
to users from the school of
business. 

• Applied Arts: Special applica-
tions, such as Gray’s anato-
my on-line could serve these
users. 

• Engineering: The power of
NeXTstep as a software de-
velopment tool has already
generated substantial interest
among computer scientists
on campus. 

I believe that we should consider
it as the primary system of choice  
for future purchases, avoiding fur 
(continued on page 9, column 1) 
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MEMO 
(continued from page 8, column 3) 

ther involvement in the plain PC
market as much as possible. I
apologize for the unabashed advo-
cacy here, but if you’d seen one of
the new NeXTs in action you
might share my enthusiasm.  
 

Systems Comparison Table 

The table below compares fairly standard, modern PC workstation alterna-
tives to the recently announced inexpensive NeXTs. Notice that the NeXT 
is superior to both the MS-DOS and Macintosh versions in all performance 
categories, and in comparable system pricing. 

 

Basic System: 
 Zenith 386/20 Mac IIsi NeXTstation 
Processor 80386 68030 68040 
Clock (MHz) 25 20 25 
Math Coprocessor $450 $300 Included 
Speed (Linpack Mflops) 0.4 0.2 2.0 
RAM (Megabytes) 4 5 8 
Hard Disk Capacity (Mb) 70 80 105 
Floppy Disk Capacities (Mb) 0.72 - 1.44 0.80 - 1.40 0.72 - 1.44 - 2.88 
Screen Size 14” 14” 16” 
Screen Resolution 640x480 640x480 1120x832 
Base Monochrome System Price $3,999 $3,992 $3,399 

Special Features: 
Ethernet Card $300 $400 Included 
Digital Signal Processor $1000 $1000 Included 

Bundled Software: 
Operating System MS-DOS Finder UNIX 
Window Manager Windows 3.0 Mac-windows NeXTstep 
Display PostScript Not Available Not Available Included 
Digital Librarian Not Available Not Available Included 
Complete Webster’s Dictionary Not Available Not Available Included 
C Compiler $100 $100 Included 
Mathematica $700 $700 Included 
Comparable System Price $6,099 $6,192 $3,399 

Minimal Color System: 
Simultaneous Colors 256 (@low res) 256  4096 
Transparency gradation Not Included Not Included 16 levels 
Base Color System Price $4,299 $3,898 $5,999 

Comparable Color systems: 

Graphics coprocessor board (hi res 4096 colors) $1,500 $1,500 Included 
Comparable System Price $7,899 $7,898 $5,999 
 

Note: The prices listed above are approximate. This is most notable for the graphics coprocessor boards, which may also differ in the total number of 
simultaneous colors per resolution, and may lack the NeXT’s transparency support. The Digital Signal Processor pricing is a guess at the difference 
between adding a DSP card with A/D converter to a PC and the cost of adding just the A/D converted to the PC, since most PC DSP boards included  
hi res A/D. These are discounted educational prices for the systems. 
 



SCaNeWS• 10 •

FIRST IMPRESSIONS 
(continued from page 5, column 1) 

Programmers will find many im-
provements to rave about.  Color  
support (a major topic in future is-
sues), several new classes and 
additional functionality to exist-
ing classes in the Application Kit
have been added.  C++ support
and new tools for measuring an
app's memory and resource utili-
zation have also been added.   
 
I was delighted to find out that the
"set" methods to initialize outlets
in new classes set up in IB are no
longer needed.  Programmers are
now encouraged to improve per-
formance by using zones for bet-
ter paging and extra .nib files for
dynamic loading of info and help
panels, etc.  Interface Builder now
provides support for the PopU-
pList, NXBrowser and NXColor-
Well App Kit classes and allows
loadable palettes.  I hope and ex-
pect to see a wealth of such pal-
ettes appearing on the net before
long.  If so, we'll pass them along.
See the on-line appendices docu-
mentation in /NextLibrary/Docu-
mentation/NextDev/
ReleaseNotes for details. 
 
I do have some complaints with
NeXTstep 2.0, however.  First,
2.0 doesn't seem any faster than
1.0 on an '030 machine (I'm dying
for our upgrades).  Apps seem to
launch faster but a variety of other
operations (e.g. Open, Save and
Print panels) seem to take longer
than before.  I do like the extra op-
tions (e.g. Home, Fax) on these
panels, though.  
 
Interface Builder doesn't hide all
the windows properly while in
"Test Interface" mode and it actu-

ally died on me while I was edit-
ing a sound in the Inspector
window. Scene, Icon and Grab
(all written by that great talent and
fontmaker Keith Ohlfs) are very
creative and can be useful but
have some idiosyncrasies.  Grab
should be able to print; Icon
shouldn't die every other time I
use it and its windows should not
be partially hidden when
launched; and Scene also dies and
violates NeXT’s UI guidelines
with its Window menu (it should
be File or Document). Scene, Icon
(and also Yap) are important apps
and I wish they were elevated to
the NextApp support level.  An-
other complaint is that the "Con-
cepts" documentation is no longer
on-line. 
 
A number of other "bugs" are list-
ed in comp.sys.next net messages
included in this newsletter.  We've
verified many of their claims. 
 
NeXT has won the Japanese G-
Mark award for outstanding ap-
pearance, functionality, quality
and safety, the Flugleman award
for its software development en-
vironment, and now BYTE maga-
zine has given them an Award of
Distinction for the NeXTstation
and NeXTdimension.  The fol-
lowing is a quote from page 159
of the January 1991 BYTE. 
 
"Steve Jobs has finally delivered
on the original promise of the
Next computer.  These machines
are fast and very inexpensive for
what they do.  Also, the applica-
tions coming out for them are, as
promised, very hot.  The Nextdi-
mension, with its powerful graph-
ics board incorporating an i860
and C-Cube CL550, will set a new

standard for video and graphics
performance.  The Interface
Builder remains the most enticing
aspect of these machines. 
 
These new systems point the way
for advanced use of color display
PostScript.  Next has taken a lead-
ing role in the migration of expen-
sive, powerful workstation
technology to cheaper, desktop
platforms.  The integration of
sound and real video is another
area in which Next is in the fore-
front." 
 

[Capitalization note:  Even ByTE got it
wrong!  The N,X and T are always capi-
talized (e.g. NeXTstation, NeXTstep,
NeXTdimension) except when directo-
ries (oops, folders) contain the name
(e.g. NextApps, NextDeveloper, NextL-
ibrary).] 
 
The comment on Interface Build-
er brings back the memory of the
first time I saw a NeXT over two
years ago.  I was really impressed
with the graphics and sound dem-
os but when I saw the power of IB
and the App kit, I flipped!  They
not only make it much more
pleasant for user interface design-
ers and programmers, they also
make the apps much better!  Let's
just hope that the world discovers
NeXTstations and NeXTstep be-
fore it's too late! 
 

NeXT Networking 
NeXT workstations will get Net-
ware client support next summer,
NeXT chairman Steve Jobs said .
The company is also working on
client and server support for Ap-
ple’s Ethertalk, which will allow
users to connect NeXT machines
to Macintoshes without using
gateways. 
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OFF THE NET 
(continued from page 5, column 3) 

csh.  Maybe there is some netinfo
setting for it? You can also limit
the size of core dumps. If the di-
rectory /cores exists and is writ-
able, core dumps will be put there 
and named "core.pid" with pid be-
ing the process id. 
 
5)  Using telnet to talk to the
NeXT from somewhere else (in
my case a 386 running AT&T
System V/386) and running "csh"
on the NeXT has become quite
flaky.  The NeXT people say that
they added something called stty -
extproc that helps somewhat.  It
solved the problem of losing char-
acters but if I type ^S to stop a
scrolling screen, things often get 
 hopelessly hung, requiring me to
kill processes on the 386 end. 
 
I had no problems with telnet on
release 1.0a.  "rlogin" still loses
huge blocks of characters, -ext-
proc or not.  This was also the
case on release 1.0a.  Interestingly
all these problems are only when
running the "csh".  If I type "sh",
commands such as "ls -l /bin" do
not drop characters. 
 
6)  The NeXT people say that the
following is done on purpose, but 
 it seems a little arbitrary to me.
Anyway, you can no longer define
a function that uses the same
name as one of the C library func-
tions or system calls in the shared
library.  Of course you can easily
change the names of your func-
tions in your code, but those old
sources that provided their own
versions of printf(), memset(),
strchr(), malloc() or whatever will
get a fatal error from ld when you
compile them.   

The NeXT people say they had to
do this because of shared librar-
ies.  Sun shared libraries don't
care if you redefine names, so it
doesn't seem as though NeXT had
to do this.   In my code (which I
port to every incarnation of
UNIX) I had gotten tired of set-
ting cpp flags as to whether a par-
ticular system used strchr() or
index(), strrchr() or rindex(),
memclr() or bzero(), etc., and so I
just supplied my own versions of
strchr(), strrchr(), etc. That
worked fine until I compiled on
2.0.  I have now changed the
names of my routines to Strchr(),
Strrchr(), etc..  No big deal.  

 
3) When you get to the # prompt
enter  
   fsck 
This checks that the filesystem is
intact on the SCSI drive. 
 
4) then enter the command that
does the backup (you should label
the disks before you backup  1 -
90) 
   # dump 0uOf 0.86 /dev/rfd0a  
 /dev/rsd0a 
this command dumps a level  
 0 full backup (zero) 
 u update the /etc/dumpdates  
  file 
 O specifies the output block  
  size (capital O) 
 f specifies a device or file 
 0.86 is the block size for 1.44  
  meg floppies with filesys 
  tem 
 /dev/rfd0a is (r) removable  
  (fd0) 1st floppy drive  
  (a) 1st partition 
 /dev/rsd0a is (r) removable  
  (sd0) 1st SCSI drive   
   (a) 1st partition 
  
Once the SCSI drive is backed up
you can use the command 
  # restore jixf filename /dev/rfd0a 
to restore any files you want. 
 j  =  media is ejectable 
 i  =  interactive mode 
   (question's asked) 
 x  =  extract files 
 f  =  specify filename 

 
Get a pen folks ... Here's how you
can backup the 105 MB Hard
Disk on the new NeXTstation to
1.44 meg floppies 
 
1) initialize (format, put a filesys-
tem on) approx 90 1.44 Meg 3 1/
2" floppies. After they have a file-
system on them there's about 1.2
Megs free. 
  
2) Turn on your NeXTstation and
when the "Loading Disk ..." win-
dow appears, hit the right COM-
MAND key and the ~ key on the
keypad at the same time. This puts
you into the ROM Monitor. You'll
get a NeXT> prompt. Enter 
   b sd -s 
This boots from the SCSI disk in
single user mode. 

BACKING UP TO

FLOPPIES . . .
Lawrence Clarke
lclarke@questor.wimsey.
 bc.ca

 
Here's a list that I've made of the
bugs in 2.0: 
(continued on page 12, column 1) 

BUGS, BUGS...

Simson Garfinkel
simsong@daily-bugle.media.
 mit.edu
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(contineued from page 11, column 3) 

Problems with EMACS: 
• .m extension doesn't automati-
cally select C-mode anymore. 
 
Problems with Webster: 
• No iconify or close buttons
(close should terminate applica-
tion) 
• Doesn't have autohide option for
autolaunch. 
 
Problems with Mail: 
• Should support the .mailrc file.
Or at least aliases; so I can send 
  mail to "kwh" and have it auto-
matically expanded to
"kwh@amt.mit.edu" without hav-
ing to mouse a half-a-dozen
things. 
• Should remember which ad-
dresses take NeXT mail and
which don't. 
• Summary matrix of articles
should take FirstMouse. 
 
Problems with Workspace: 
• When new icons get created in
the lower-right, they should be 
created as down and as right as
possible.  Right now, it seems to 
count across each time a new app
is created.  But if I delete a run-
ning app, it doesn't reclaim the
space  until it has gone all the way
around... 
• NeXT still doesn't have a screen-
saver... 
 
Problems with Digital Librarian: 
• 1.0 .index files breaks the index-
er; it doesn't delete them, it just
crashes. 
• Doesn't have autohide option for
autolaunch. 
• Makes another directory in my
home directory (~/Library), rather

than putting bookshelves into the
.NeXT directory. 
 
Problems with Usermanager: 
• Help screen says that there is a
delete user option under the Win-
dows menu, but there isn't. 
 
Problems with Terminal: 
 
• esc prefix is not the same as meta 
• does not work properly with
emacs. (in particular, scroll line
up...) 
 
Problems with EMACS & GDB: 
• meta-D / meta-U / meta-S /
meta-N work if you type ESC-D,
but if you type a real META-D
(because you have a copy of Stu-
art that does the right thing), then
you have to press the META-D
twice. 
 
Problems with Terminal: 
• Command-Q should ask you be-
fore it quits. 
• Regular VT100 emulation
doesn't work properly with emacs. 
 
Problems with Interface Builder: 
• If you close a nib file and have
the Connections inspector out,
you get trash in the Connections
inspector 
• You can't add a .tiff or .eps image
with a space in its name. 
 
Typos in documentation: 
• in /NextLibrary/Documentation/
NextDev/ReleaseNotes: 
 The "- alloc" should be a "+ al-
loc" 
¶• in /usr/include/appkit/Cursor.h: 
 Should include "obsoleteBit-
map.h", not "Bitmap.h" 
 
 
(continued on page 13, column 1) 

NeXTAnswers 
(continued from page 7, column 3) 

The following files in the Novem-
ber 1990 release of NextAnswers
are additions or revisions to the  
October release.  Some of the re-
visions are trivial. 
 
NEW SINCE OCTOBER: 
color.607 
hardware.568 
hardware.579 
hardware.581 
hardware.586 
hardware.608 
misc.558 
misc.562 
misc.567 
misc.575 
misc.587 
misc.599 
misc.603 
netinfo.598 
netinfo.601 
objc.584 
objc.591 
objc.605 
sybase.597 
sysadmin.600 
tiff.566 
video.578 
 
REVISIONS: 
INSTALL.wn 
README.wn 
appkit.503 
mail.451 
misc.227 
network.389.wn 
sound.267 
sysadmin.82 
sysadmin.296 
sysadmin.298 
sysadmin.326 
sysadmin.400 
sysadmin.549 
sysadmin.556 
workspace.309 
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(continued from page 12, column 2) 

Requests for Matrix: 
• matrix should have a Selected-
CellCount method which returns
the number of SelectedCells. 

I'm going to assume that you are
using PageMaker 4.0 and Word
4.0. Sorry. 
 
Open a New Document in PM.
Select the TEXT tool. Type a
word. I typed in the name of the
font I was going to use. Select the
text you just typed, and change
the font with the font menu. 
 
Continue to do so with each font
you have, other than the ones that
come with the NeXT (Courier,
Helvetica, Symbol, and Times
families). Make sure that you get
every version of the typeface
available (AvantGarde-Demi,
AvantGarde-BookOblique,
AvantGarde-DemiOblique,
AvantGarde-Book --- You get the
idea). The NeXT will automati-
cally separate the type families
from the type weights, and organ-
ze them for you just like Adobe
Type Reunion on the Mac. 
 
Now you should have a whole
bunch of lines, each one in a dif-
ferent typeface. Save the docu-
ment (you never know!). Now
Print from the File menu. In the
Print Dialog box, make sure you
tell PM to print to a printer that
you do not have attached to your
computer. That is, don't choose
Laserwriter or General. I told it a
Linotronic.  
 
That brings up another point: You
must have Laserwriter chosen
from the Chooser. Otherwise,
Pagemaker, and I assume most
other programs, won't have the
PostScript option available for
printing. Whether or not you real-
ly have a PS printer is academic at
this point. You won't be printing
anything.  

OK...Now you have to tell the
program to print the file to disk.
IN PM, you click on the Post-
Script button. Deselect EVERY-
THING you see EXCEPT Print
PostScript to Disk and Download
Postscript Fonts. 
 
Give the 'Print to disk' file a name.
Call it bunchafonts or something. 
 
Go ahead and print. Your hard
drive should whirr for a while,
then stop. 
 
Now exit this program and start
your Word Processor. Open the
file that you just printed to disk.
You will see a very, very, very
long document containing a mess
of PostScript code. Here comes
the fun part. 
 
Somewhere in all that mess, are
the lines  
        %%Begin Font 
        and 
        %%End Font 
 
Guess what's in between those
lines...That's right! Your font. The
Begin font comment should also
contain the full name of the font,
so you don't really have to remem-
ber which order you printed them.
Open a new window, and copy all
the lines between the Begin Font
and End Font comments into the
new document. Save the new doc-
ument, with the FULL NAME of
the font. This will save you grief
later. If you're using Word 4.0,
make sure you use SAVE AS, and
save as TEXT ONLY, not TEXT
ONLY w/LINE BREAKS. 
 
Once you've done this with all  
(continued on page 14, column 1) 

 

 
OK...Before I get too many more
requests, here's how I made my
Type 1 PostScript Fonts from my
Mac work on the NeXT: (well,
most of them work). 
 

DISCLAIMER: You are ultimately re-
sponsible for your own actions. I take
no responsibility for anyone who might
decide to use these fonts on more than
one machine, in violation of Adobe's li-
censing agreement. 
 
Before I get into the hows, let me
tell you what you need. 
 
• A page layout program or simi-
lar that can print PostScript to
disk. I used PageMaker 4.0. 
• A word processor that can save
in TEXT-ONLY mode. I used MS
Word 4.0. 
• Some way of transferring the
TEXT files from the Mac to the
NeXT. I used Apple File Ex-
change, to convert the Mac TEXT
files to an IBM format. Then I put
the IBM disk in my AT, and ftp'ed
to the Cube. That was the fast way
to do it. Kermit or such should do
the job just fine.  
 
OK...Now that you have all this,
and think you can continue, read
on... 

MAC TO NeXT
POSTSCRIPT
FONT CONVERSION
Michael Callaghan
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(continued from page 13, column 3) 

your fonts, you're ready to trans-
fer the files to the NeXT. Do this
however you can. 
 
Once the fonts are on the NeXT,
you face the most fun problem of
them all. The end of line charater
on the Mac is ASCII(13) (CR or
^M). On the NeXT, it's ASCII(10)
(LF or ^J). If you used filters
when you transferred the files,
you may have been able to convert
CRs to LFs. If you used an IBM 
filter, as I did, it converted CRs to
CR/LF combinations.  
 
Whatever happened, you now
have to get rid of all CRs in the
files, and replace them with LFs,
assuming they're not already
there. I have a program a friend of
mine wrote that will do this. 
 
OK...You now have a whole
bunch of text files. Now you have
to get Adobe to send you the cor-
responding AFMFiles. This is
easy. Here's an example for get-
ting AvantGarde typefaces from
Adobe. 
 
mail ps-file-server@adobe.com 
SUBJECT: send AFMFiles
AvantGarde-Book 
send AFMFiles AvantGarde-
BookOblique 
send AFMFiles AvantGarde-
Demi 
send AFMFiles AvantGarde-De-
miOblique 
^D 
cc: 
 
This will tell the adobe file server
that you want the above AFM
files.  

You have to do this for each type-
face you want to use. I suggest do-
ing the requests separately for
each typeface, as the file the serv-
er sends back will be pretty long if
there are too many requests.  
 
The file the server mails back to
you will be in the form of a shell  
archive. You just strip out the mail
header, and issue a sh filename
command from a shell window on
the NeXT.  
 
Copy the shell archive into your /
LocalLibrary/Fonts/afm directo-
ry. 
 
Copy the fonts you got from the
Mac into the /LocalLibrary/Fonts/
outline directory.  
 
Unpack the shell archive using the
/bin/sh 'filename' command. You
may have one more problem left.
The afm files I got from Adobe
had the CRs in it. I had to run my
little program on all the files once
again.  
 
Now, you should have two direc-
tories full of text files: the afm and
the outline directories. Now cd to
the /LocalLibrary/Fonts directory, 
and issue the following command: 
 
buildafmdir . 
 
This will tell the NeXT to make
its own directory for the new
fonts. 
 
If you make it through all this
without an error, most of your
fonts should work. I still have
three that do not.  
 

If there are any specific questions,
or you need the program, let me
know. 

 
There has been a great deal of dis-
cussion recently concerning
X11R4 on the NeXT and Pencom
Software's role in providing it.
Since others have seen fit to begin
this discussion, allow me reply
and clarify a few points. 
 
• Yes!  Pencom Software has an-
nounced and has a working alpha  
version of "co-Xist", an imple-
mentation of X11R4 under
NeXTstep 2.0. This grey-scale
version will be in beta in February
and will be released in March.  A
color implementation is planned
for a future release.  
 
• Yes, we did consider providing
some means of copy protection
for the product. Ours is an imper-
fect world and people DO pirate
software.  But we're software de-
velopers, too --   and  aren't partic-
ularly fond of copy protected
software, either.  For the first re-
lease, co-Xist will NOT be copy  
protected and site licenses will be
available.  We will review that
policy for future releases based on
our experiences.  
 
As suggested, and what we con-
sidered ideal, we will be selling
co-Xist at a low price per CPU
($149 for educational accounts,
$249 for commercial accounts),   
(continued on page 15, column 1) 

X on the NeXT
Dany Guindi
Pencom Software
pensoft!dany@
 cs.utexas.edu
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(continued from page 14, column 3) 

we will also make site licenses  
available and will support our
product. We, to quote a recent
poster, will protect our interest by
providing "a low price and good
support". 
 
• No, our code is by no means
simply a productized version of
the work done by McGill Univer-
sity.  Since their implementation
of X11R4 for NeXTstep 1.0 is in
the public domain, we did look at
it to see what approach they took.
We, however, chose to design co-
Xist to run inside a NeXTstep
window as opposed to the McGill
approach of taking over the dis-
play with a hot-key toggle be-
tween the two environments.   
 
co-Xist will also optionally in-
clude OSF/Motif 1.1 and the stan-
dard MIT X documentation in a
form compatible with NeXT's
Digital Librarian. 
 
• Unlike McGill, we have had
GREAT support from NeXT, and
I can't emphasize this enough--
NeXT support has been great and
they get an enthusiastic
THUMBS UP! Yes, we are aware
of the religious issue of X versus
NeXTstep and yes, we had to
overcome some obstacles. We
might as well go ahead and thank
the two people most responsible
for our success... Chris MacAskill
and Scott Abel (both from
NeXT). Again, thanks guys!!! 
 
If you have any questions and/or
comments please feel free to re-
spond via e-mail or contact me at
512-343-1111.  
 

Dany Guindi 
 (pensoft!dany@cs.utexas.edu) 
Pencom Software 
9050 Capital of Texas Highway,
Suite 300 
Austin, TX 78759 

For the most part, anything that
can be done using the tool panels
can also be accomplished via the
menu, which also has numerous
additional features. The kerning
submenu in particular offers more
flexibility than the kerning tool
panel, allowing the user to touch
kern (i.e. adjust the spacing so that
adjacent letters are touching), to
save a particular kerning in a file
for later use, and to automatically
return to natural letter spacing if
an effect didn't quite turn out as
expected.  
 
The Format submenu has options
for aligning text lines, adjusting
spacing between words, and rotat-
ing selected text by arbitrary de-
grees. Since the program makes it
so simple to move text--individual
letters can be removed from their
place in a line merely by selecting
and dragging--there is also a
handy "back to baseline" option
which will realign them. Be
warned, however, that this option
only produces the correct result
when the letters are merely out of
horizontal alignment: if you've
been swapping them around, use
Edit/Fix Selection to return them
to their original positions. 
 
To gain a variety of visual per-
spectives of the text, the Windows
submenu offers incremental larg-
er and smaller window zoom, a
handy zoom back to default, and
the extremely handy zoom  
 
WYSIWYG (What You See Is
What You Get), which zooms to
an exact representation of printer
output. It's much faster than the
Previewer available from the Print
submenu.  
(continued on page 16, column 1) 

 
TOUCHTYPE 
(continued from page 6, column 1) 

Billed as a set of visually-orient-
ed, intuitive tools for setting large
size type, the program's features
can be mastered in less than an
hour by someone familiar with the
NeXT environment. The two help
windows, Basic Help and Power
Help, are more than sufficient to
accomplish straightforward type-
setting tasks without recourse to
any written documentation. 
 
The heart of the available tools
consists in a set of tool panels, in-
cluding: 
 
Font and Size Picker Panels: The
font panel font size options range
from 8 pts to 64 pts, and the font
size picker ranges from 24 pts to
250 pts, permitting a maximum
text size of 2-1/2 inches. A nice
feature of both is their preview
windows, illustrating what the se-
lected font will look like before it
is applied to the document. 
 
Ruler Guides: These resizable,
movable, horizontal and vertical
rulers are often handy to drag into
the middle of a document to mea-
sure the size of a piece of text,
particularly for those of us who
aren't used to thinking in "points".
As an additional nicety, when
zooming the edit window larger or
smaller the ruler markings also
zoom to the appropriate scale. 
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TOUCHTYPE 
(continued from page 15, column 3) 

Finally, when you have finished
playing with these features and
have no clue how to fix the mess
you have created onscreen short
of global erase, the Edit submenu,
in addition to the usual cut, copy
and paste, incorporates bailout
options. For localized disasters,
Fix Selection will attempt to re-
construct a coherent version of the
selected text, while Fix Every-
thing rearranges the entire screen.
The latter option may produce
some rather bizarre results, but the
program is kind enough to warn
you of this fact and prompt for
confirmation before proceeding.  
 
And, by and large, it does a pretty
good job of cleaning things up: I
scattered the letters of a text line
around on the page, rotating a
copy of several of them and swap-
ping the positions of several oth-
ers, and it gathered up all of the
original letters and put them back
in their proper order, although
rather than putting them in their
original position it rearranged
them onscreen starting wherever
the first letter of the line happened
to be. 
 
Without a doubt, TouchType is
simple to learn and to use and pro-
duces impressive printed results
with a minimal amount of effort.
But I found a certain awkward-
ness in the user interface, mani-
fested not so much in a few
monumental design blunders
(there were really none of those)
as in an accumulation of small an-
noyances, program features that
invariably left me wondering,
"Why did they do it THAT way?"
A sampling of these features: 

The curious behavior of windows 
All of the tool panels except the
ruler guides may be obscured by
the editing window. This is a par-
ticular nuisance with the Tools
panel, both because it is a very
small and hence easily obscured
window, and because changing
cursors and moving text are fre-
quently performed operations.
The program might have taken the
FrameMaker route and left the
tool panels front as long as the ap-
plication is active, so you can al-
ways find them easily. This might
be a design judgment call: some
people probably hate dragging
panels out of their way when they
need to edit. But, on the other
hand, there are many circum-
stances, particularly in a format-
intensive program such as
TouchType, when mouse move-
ment would be significantly mini-
mized if the tool panel could
overlay the active editing window. 
 
The ruler guides, in contrast, are a
little too forward. They stay front
all of the time, even when another
application is active. If, like me,
you tend to have several applica-
tions open at once and bounce
back and forth between them, this
is a source of frustration, and I
can't see any design justification
for having to drag TouchType rul-
ers out of the middle of, say, Dig-
ital Librarian. 
 
Undoing justification 
A necessary feature of any intui-
tive text processing program is the
ability to easily undo any format-
ting experiments gone awry. For
the most part, TouchType per-
forms admirably in this respect:
given a submenu with formatting
options, the same submenu gener-

ally provides a mechanism for
"unapplying" those formats. The
Format/Text/Align Justified op-
tion does have a quirk, however. If
a line of text contains more than
one word, the program performs
justification by increasing the
spacing between words. If it con-
tains a single word, justification is
achieved by increasing the spac-
ing between letters. The former
may be undone merely by select-
ing a different justification option
from the same submenu. Undoing
the latter requires you to go to the
Kerning submenu and select Nat-
ural Letter Spacing, not exactly an
intuitively obvious operation. 
 
Copying text 
One way to make copies of select-
ed text is to hold down the Alt key
while dragging the mouse. Much
to my dismay, I found the behav-
ior of this feature to be somewhat
erratic: sometimes the program
would make copies, as it should,
but other times it would merely
move the text. Worse still, the
original text looked as if it was
still in its original position, only to
disappear when I did a screen re-
draw or a printout. A subsequent
chat with a TouchType represen-
tative revealed that this is an ap-
parent bug. The workaround for it
is to hold down the Alt key not
only while dragging, but also
while selecting the text.  
 
Granted, even considered cumula-
tively, these minor inconvenienc-
es are not sufficient to render the
program unusable. But with a rel-
atively limited repetoire of fea-
tures, a self-avowed focus on ease
of use, and a $250 list price, one
expects not to be inconvenienced
at all. 
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Help 
One convenience of Mathematica is the
“Help”  option on the main menu at the upper
left corner of the screen.  If you select this, a
submenu will pop up that includes an option for
a quick explanation of the beep that occasional-
ly signals that you have made an error.  In addi-
tion, there is a help cursor.  You can select this,
and then move around the menu with the mouse
until you find the desired option.  Click the
mouse, and a help window will arise for that
option. 
 
If you want to receive additional information
on Mathematica, select the “Info”  option from
the main menu.  This has a general help win-
dow, but also an option to create a registration
form.  Select this option to display the form,
then fill it out, and print it.  If you send it on in
to Wolfram Research, Inc. they will send out
the requested information. 
 
Working in Mathematica 
Enter expressions into Mathematica merely by
typing them in.  If your formula doesn't all fit
on one line, you may continue on additional
lines (just press “Return”).  To actually start the
evaluation of the expression, press the “Return”
key while holding down the "Shift” key.  You
will use this “Shift-Return” key combination
repeatedly throughout your session.  A simple
calculation is quite easy: 
2 + 3/4        ←Type in the formula, then  
 press “Shift-Return” 
You obtain:  

2 + 3/4  

11 
-- 
 4 

You could also use symbolic expressions: 

In[1]:=In[1]:=

In[3]:=Out[1]

  

(x+1) (x^2 + 2x y + 4y^2 -3)  

(1 + x) (-3 + x2 + 2 x y + 4 y2) 
Note that multiplication is indicated by juxta-
positioning the components of the product, as
in standard mathematical notation (or, option-
ally with “* ”).  Addition, subtraction, division,
and powers are obtained with familiar symbols:
“+”  “ -”  “ /”  and “̂ .” Standard mathematical
constants, such as “π,” “ i,” and “e” are built
into Mathematica.  Their names follow the rule:
“Standard system functions always begin with
a capital letter for each word in the name --
even if they have only one letter names.”  Thus
they may be obtained as:  “Pi ,” “ I ,” and “E.”
The functional form, “Exp[] ,” provides an al-
ternative for  “E.”  There is even a constant for
∞:  “Infinity .” 
You can refer back to the previous expression
with the abbreviation “%”:  

Expand[%]  

-3 - 3 x + x2 + x3 + 2 x y + 
2 x2 y + 4 y2 + 4 x y2 

The expanded expression can also be separated
back into its primary factors:  

Factor[%]  

 (1 + x) (-3 + x2 + 2 x y + 4 y2) 
Expand and Factor are functions that modify
the appearance of expressions.  An entire series
of related functions allows you to pick apart
and reassemble formulas in whatever form
seems most attractive.  The percent signs al-
ways refers to your previous expression.  Refer
to the penultimate expression with “%%,” or
any particular formula appearing  earlier in
your session notebook by “%n,” where “n” is
the expression number that shows up on the 
(continued on page 18, column 1) 

In[1]:=In[2]:=

In[3]:=Out[2]

In[1]:=In[3]:=

In[3]:=Out[3]

In[1]:=In[4]:=

In[3]:=Out[4]
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“ In[#]:= ” prompt (its sequence number for the
session). 1 
We can evaluate expression #2 with y set to 5
as follows: 

%2/.y->5 
(1 + x) (97 + 10 x + x2) 

Further substitution of 2.22 for x gives: 
%/.x->2.22 
399.693448 

Use of decimal numbers automatically induces
numeric results.  If, instead, you put in a ratio-
nal form of the expression, you get exact re-
sults: 

%%/.x->222/100 
 49961681 
------------ 
  125000 

You can also force numeric evaluation by plac-
ing the expression within the “N[] ” function or
appending “//N ” after the expression.  For ex-
ample: 

123/456  +  321/654 //N 
0.7605625301786576 

Note that multiplication is indicated by juxta-
positioning the components of the product, as
in standard mathematical notation (or, option-
ally with “* ”).  Addition, subtraction, division,
and powers are obtained with familiar symbols:
“+”  “ -”  “ /”  and “̂ .” Standard mathematical
constants, such as “π,” “ i,” and “e” are built
into Mathematica.  Their names follow the rule:
“Standard system functions always begin with
a capital letter for each word in the name --
even if they have only one letter names.”  Thus
they may be obtained as:  “Pi ,” “ I ,” and “E.”
The functional form, “Exp[] ,” provides an al-
ternative for  “E.”  There is even a constant for
∞:  “Infinity .” 

You can refer back to the previous expression
with the abbreviation “%”:  

1. These prompts will be omitted henceforth in this handout. 

In[1]:=In[3]:=

Expand[%]  

-3 - 3 x + x2 + x3 + 2 x y + 
2 x2 y + 4 y2 + 4 x y2 

The expanded expression can also be separated
back into its primary factors:  

Factor[%]  

 (1 + x) (-3 + x2 + 2 x y + 
4 y2) 

Expand and Factor are functions that modify
the appearance of expressions.  An entire series
of related functions allows you to pick apart
and reassemble formulas in whatever form
seems most attractive.  The percent signs al-
ways refers to your previous expression.  Refer
to the penultimate expression with “%%,” or
any particular formula appearing  earlier in
your session notebook by “%n,” where “n” is
the expression number that shows up on the
“ In[#]:= ” prompt (its sequence number for the
session). 2 

We can evaluate expression #2 with y set to 5
as follows: 

%2/.y->5 

(1 + x) (97 + 10 x + x2) 

Further substitution of 2.22 for x gives: 

%/.x->2.22 

399.693448 

Use of decimal numbers automatically induces
numeric results.  If, instead, you put in a ratio-
nal form of the expression, you get exact re-
sults: 

%%/.x->222/100 

 49961681 

------------ 

  125000 

 
(continued on page 19, column 1) 

 

2. These prompts will be omitted henceforth in this handout. 

In[3]:=Out[3]

In[1]:=In[4]:=

In[3]:=Out[4]
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You can also force numeric evaluation by plac-
ing the expression within the “N[] ” function or
appending “//N ” after the expression.  For ex-
ample: 

123/456  +  321/654 //N 
0.7605625301786576 

The numeric evaluation function ,”N[] ,” also
offers a second argument to specify the preci-
sion: 

N[Pi,50] 
3.1415926535897932384626433
832795028841971693993751 

The previous examples illustrated some other
forms of Mathematica notation along the way.
The appendage “/.x->2.22 ” specifies re-
placement of portions of an expression (“/. ”)
according to a standard substitution rule. In this
case, the rule “x->2.22 ” causes replacement
of “x.”  Substitution rules of this sort frequently
arise in other contexts in Mathematica as well.
Functions with arguments illustrate another
form of notation:  "[] ," where the arguments
appear as a list inside brackets that follow the
function's name. 
You can also set values for variables, such
as”x,” or “y,” with an assignment statement: 

x=2.22; y=5  ←Notice that I put two 
statements on the 
same line separated 
by a semicolon. 

Now when you use these variables, there values
are automatically substituted in: 

(a + b x) (2x^2 + 3 x y + 
4y^2 + 10) 
153.1568(a + 2.22 b) 

If you want to erase the value for a variable, to
return it to symbolic use, assign it to “nothing”
as represented with a period: 

x=.; y=.; Expand[(a + b x) 
(2x^2 + 3 x y + 4y^2 + 10)] 
10a + 10b x + 2a x2 + 2b x3 
+ 3a x y + 3b x2 y + 4a y2 + 
4b x y2 

Multi-character names are permitted for vari-

ables, (eg. george=12). However, to avoid con-
flicts with built in Mathematica names, you
should use lower case letters for the names (at
the very least, use a lower case letter to start the
name).  Names, of course, must start with an al-
phabetic character (never a numeric digit). 
Note:  Since multi-character names are possi-
ble, you must always take care to separate dis-
tinct variables in expressions.  Overlooking this
requirement is a common error: 

Factor[x^2 + 2xy + y^2] ← 
Here the "x" and "y" are jammed together 
and   treated as one variable, unrelated to "x" 
or "y." 
x2 + 2 xy + y2 

Factor[x^2 + 2x y + y^2] ← 
This fixes the problem. 
(x + y)2 

 
Editing expressions the convenient
way:  with the mouse 
The graphical interface  provided by Mathe-
matica offers particularly easy ways to edit
your expressions.  You can actually move the
mouse up on top of an existing formula, click
on it, and then edit the contents with ordinary
keyboard commands.  When you press “Shift-
Return” after finishing your edits, the expres-
sion will be re-evaluated, and new output will
replace the previous.  If this occurs in the mid-
dle of the notebook, the output from later ex-
pressions will be saved, and shifted up or down
as necessary. 
 
Moving or copying expressions (or portions
thereof) is also easy with the mouse.  Slide the
mouse to the start of the target text, press down
the mouse button, and drag it across to the right.
The selected text will be marked with gray.
Once all of the desired text has been selected,
lift the button.  Click on the Edit menu, and
then on its Copy option.  Then mouse back
down to the location where you want the copy
inserted.  Click the mouse to position yourself
in this area.  Then return to the Edit menu, and  
(continued on page 20, column 1) 
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click the Paste option.  Move the mouse back to
the main window at the point inside the newly
copied text that you wish to edit.  Click there to
bring up the text editing bar.  Make your chang-
es and press “Shift-Return” to evaluate the re-
vised expression. 
You can tear off a copy of the edit menu and
move it over closer to your document if you
wish. Just grab it by placing the mouse on its ti-
tle bar, pressing down the mouse button, and
dragging it to the new location.  There are also
keyboard shortcuts available for the common
edit commands.  These appear in green on the
keys at the lower left, and operate in combina-
tion with the “Command” key, when it is
pressed like a shift key: 
   Command-C:  copy     Command-X:  cut
Command-V:  paste     Command-Z:  undo 
 
Lists (vectors) 
Lists of objects (numbers, variables, expres-
sions, etc.) can be constructed and manipulated
easily with Mathematica.  These also form the
basis for handling of vectors and matrices (de-
scribed in more detail later in this handout).
Lists are made by separating the members by
commas, and enclosing them in braces (ie.
{ •,•,•,… }).  The lists can then be included in
expressions, producing new lists as output.  For
example: 

{2,4,6,8}x^{2,3,5,7} 
gives: 

{2x2, 4x3, 6x5, 8x7} 
or: 

Expand[(1+zed){3, 2+3a, 
4+9a+17a^2}] 

yields: 
{3 + 3zed, 2 + 3a + 2zed + 
3a zed,  
4 + 9a + 17a2 + 4zed + 9a zed 
+ 17a2 zed} 

You can pick out individual elements of lists by
using double brackets: 
 

{a,b,c,d}[[2]] 
b 

Double brackets are used for indexing in order
to distinguish from the specification of function
arguments.  There are the four main bracketing
schemes in Mathematica: 
 (expression) ← parentheses
group expressions to control calculations 
 Function[arg] ← brackets en-
close arguments for functions 
 { •,•,•,… } ← braces en-
close lists (vectors) 
 { •,•,•,… }[[ index]] ← double brack-
ets index into lists 
 
Creating your own Functions 
You can build functions in Mathematica from
expressions involving existing functions quite
easily.  Sophisticated programming facilities,
such as loops, if-then constructs, etc. are also
available.  Follow the same rules for function
names as for variable names (in particular, start
them with lower case letters).  Assignment
statements allow you to create functions.  How-
ever, there are two types of assignment to
choose from.  Ordinary “=” as is used with
variables, evaluates your expression immedi-
ately, and then puts it into the function.  De-
layed assignment (with “:= ”) stores the
expression in the function and then evaluates it
when the function is used.  The delayed assign-
ment is generally best approach for defining
functions, for example: 

esin[theta_] := Exp[theta] 
Sin[theta] 

creates a function that can be used with numer-
ic or symbolic arguments: 

esin[3Pi/2] 

-E((3*Pi)/2) 

esin[3.0012] 

2.813982414021476 

esin[a + 2b] 

E(a + 2b)Sin[a + 2b] 
(continued on page 21, column 1) 
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Look closely at the argument in the definition for “esin .”  Note the trailing underline.  It causes
the corresponding variable name, “theta,” to treated as a formal argument to the function.  This im-
plies that the actual argument supplied to the function (eg. “3Pi/2 ”) should be substituted into the
original expression wherever “theta” appeared.  The trailing underline is necessary.  Omitting it
undermines argument substitution. 
 
Saving your work 
Once you have created your functions, there are two ways of saving them.  You can save your en-
tire Mathematica notebook by selecting “Save” from the “Window” menu.  Alternatively, you can
issue a save command  (eg. Save["filename",esin ,•,•,•,… ] ) and later call the functions
back into any notebook (not necessarily a continuation of your current session) with Mathematica's
retrieve command: <<filename .  When saving an entire notebook for the first time, assign it a
name other than the default (Untitled-1).  Do this by selecting “Save as” from the "Window" menu.
A panel will pop up with a mini-directory-browser, allowing you to select the location, and then
type in the name for your notebook.  You can also save your work quickly at any time with the
“Command-s” key combination.  Recall the notebook with “Window” -- “ Open.” 
 
Calculus 
Mathematica knows enough about calculus to handle symbolic differentiation, integration, and
limits.  For example, to differentiate”tan y/(ex sin x),” type in: 

D[tan y/(E^x Sin[x]),x] 
to get: 

-(Tan[y] Cos[x])/(Ex Sin[x]2) - Tan[y]/(Ex Sin[x]) 
Note:  Make sure that you specify system functions correctly (not as mere variables): 

D[sin x,x] 
gives you: 

sin 
when you might really desire: 

D[Sin[x],x] 
to get: 

Cos[x] 
Taking second derivatives is equally easy: 

D[Tan[y]/(E^x Sin[x]),{x,2}] 
gives: 

 2 Cos[x]2 Tan[y]  2 Cos[x] Tan[y]   2 Tan[y] 
---------------- + --------------- + --------- 
   Ex Sin[x]3         Ex Sin[x]2      Ex Sin[x] 

Derivatives with respect to both x and y just require one more argument (y):  
    D[Tan[y]/(E^x Sin[x]),x,y] 

to get: 
     -Cos[x]                  1 
------------------  -  ---------------- 
Ex Cos[y]2 Sin[x]2     Ex Cos[y]2 Sin[x] 

(continued on page 22) 
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Feasible indefinite integrals can also be obtained: 
Integrate[Cos[theta] Sin[theta],theta] 

provides: 
-Cos[theta]2 

------------ 
      2 

Explicit formulas for definite integrals can often be found: 
Integrate[x Sin[x],{x,a,b}] 

results in: 
a Cos[a] - b Cos[b] - Sin[a] + Sin[b] 

Occasionally these reduce to simple numeric expressions: 
Integrate[z^10 Exp[-10z], {z,0,Infinity}] 
567/15625000 

The numeric form could have been chosen instead, either by first symbolically integrating: 
Integrate[z^10 Exp[-10z], {z,0,Infinity}]//N 

or directly with numerical methods (most useful when symbolic integrals don’t exist): 
NIntegrate[z^10 Exp[-10z], {z,0,Infinity}] 

to obtain: 
0.000036288 

Power series approximations to functions can be carried to an arbitrary number of terms: 
Series[Exp[x]Sin[x], {x,0,10}] 
           x3     x5     x6     x7      x9        x10 

x  +  x2  + --  - --  -  --  -  ---  +  -----  +  ------  + O[x]11 
           3     30     90    630    22680     113400  

Limits may also be obtained: 
Limit[Sin[x]/x, x->0] 

gives: 
1 

 
Solving equations 
Mathematica can also solve equations: 

Solve[a y^2 + b y + c == x, y] 
{{y -> (-(b/a) + (b2/a2 - (4(c - x))/a)^(1/2))/2}, 
 {y -> (-(b/a) - (b2/a2 - (4(c - x))/a)^(1/2))/2}} 

Even simultaneous equation sets can be handled: 
Solve[{a x + b y == r,c x + d y == s},{x,y}] 
{{x -> (d r)/(-(b c) + a d) - (b s)/(-(b c) + a d),  
  y -> -((c r)/(-(b c) + a d)) + (a s)/(-(b c) + a d)} 

While you can attempt much more taxing equation solving problems, these may yield huge
amounts of output (too much to print here). 
 
 
 
(continued on page 23) 
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Matrices 
Mathematica allows you to construct matrices by nesting lists of lists: 

mx = {{a,a^2},{a b,a^2 b}} ←Note that youcan press “Return” in the middle of an 
     {{a, a^2}, {a*b, a^2*b}} input line, to continue on the next line. That is 

why “Shift-Return” is needed to start it running. 
To display them in matrix format, use: 

TableForm[mx] 
 a a2 

 a b a2 b 
More elegant matrix manipulations are also possible: 

Eigenvalues[mx] 
{a (1 + a b), 0} 

or: 
Inverse[{{ 2 x,  3 x^2,  5 x^3}, 
 { 7 x, 11 x^2, 13 x^3}, 
 {17 x, 19 x^2, 23 x^3}}] 
{{ -1/(13x),  -1/(3x),   8/(39x)},  
{-10/(13x2),  1/(2x2), -3/(26x2)},  
{  9/(13x3), -1/(6x3), -1/(78x3)}} 

 
Extended output facilities 
Equations, graphics, and other material can be organized into complex, structured notebooks inside
of Mathematica. This exploits the hierarchy of cells described in detail in Wolfram’s book. Ouput
from Mathematica can also be cut (or copied) with mouse edits, and then pasted in to other appli-
cations, such as Write-now. However, Framemaker provides a clearly more powerful alternative
for document development. This handout was produced by pasting Mathematica cell contents into
Framemaker. Mathematica can also build suitable output files for typesetting with TEX to obtain
truly gorgeous equations. 
 
Graphing with Mathematica 
You can produce graphs in Mathematica in much the same way that you would do anything else:
by executing functions.  Standardly available graphing functions include: Plot  (for X-Y plots),
ParametricPlot , Plot3D , ContourPlot , and DensityPlot .  These plot parametric
functions that you specify.  If you wish to plot raw data values, another series of plot functions
(with the same names prefixed by "List ") offers that capability. 
The following example  shows how easy it is: 
 

Plot[Sin[x],P{x,0,5}] 
 
 
 
 
(continued on page 24) 
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On the NeXT, modifying the plot is quite easy as well: 
 

Plot[Sin[8 Pi x], {x,0,5}] 
  

Making a copy of the plot request is equally easy: 
Mouse up to the start of line used for the previous plot request, press down the mouse button, and
drag it across to the right.  The selected text will be marked with gray.   Once all of the desired text
has been selected, lift the button.  Click on the Edit menu, and then on its Copy option.  Then mouse
back down to the empty page area below your existing graphics output.  Click the mouse to position  
(continued on page 25) 

1 2 3 4 5
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1 Note that "Plot" takes
two arguments, the
function to graph, and
a list specifying the X
axis range for  the cho-
sen function.  The list
includes the X axis
variable name fol-
lowed by the lowest
and highest values to
plot.  As always, the
list must be enclosed in
braces. 

1 2 3 4 5

-1

-0.5

0.5

1

Merely use the
mouse to move the
cursor to the spot
in the original in-
put line where you
wish to make
changes.  Then
click it, and type in
the changes (here
adding "8 Pi " in
the argument to
Sin, to create more
waves).  Press
Shift-Return to re-
run the plot. 
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yourself in this area.  Then return to the Edit menu, and click the Paste option.  Move the mouse
back to the main window at the point inside the newly copied text that you wish to edit.  Click there
to bring up the text editing bar. 
Make your changes and press Shift-Return to run the new plot request:  
 

Plot[ Exp[-x/5] Sin[8 Pi x], {x, 0, 5}] 
  

 Often, placing complex expressions inside the plot request seems cumbersome.  You can avoid
this by defining the expression as a function (with delayed assignment ":="), and then using this
function in the plot request: 
 

damped[x_] := [ Exp[-x/5] Sin[8 Pi x], {x, 0, 5}] 
Plot[damped[x], {x, 0, 5} 

  

 
(continued on page 26) 
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If you wish, you may use the
keyboard as a shortcut for
cut/paste.  Pressing down the
"Command" key and tapping
the "C" key does a copy re-
quest.   Command-V then
pastes the material back in.
Command-X can be used to
move, rather than copy text.
If you prefer to have the Edit
menu close at hand, you can
drag a copy by its title bar to
wherever you need it. 
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Mouse-based cut & paste editing is quite convenient when you are developing formulas or plot re-
quests.   It gives you greater flexibility than the use of "%" for previous expression, "%%" for pen-
ultimate expression, and "%n" for the nth expression of the session.  You may copy portions of
aline just as easily as entire lines.  You can even copy the material into other applications (such as
Write-Now) by pasting into an open window for that application.  You can easily add material to
a formula by just mousing over to the desired spot, clicking, and typing.  Doing this to the previous
plot in order to explicitly control the range for plotting on the y-axis improves upon the previous
plot: 
 

Plot[ damped[x], {x, 0, 5}, PlotRange->{-1, 1}] 
  

Further modification of the X-axis range helps even more: 
 

Plot[ damped[x], {x, 0, 2}, PlotRange->{-1, 1}] 
  

(continued on page 27) 

1 2 3 4 5

-1

-0.75

-0.5

-0.25

0.25

0.5

0.75

1

Plot has quite a variety of op-
tional arguments, eg.
PlotRange, which manually
sets the Y-axis range.  These
are listed out after the function,
and X-axis specifications be-
fore the closing bracket.  They
exploit the substitution opera-
tor "->" to assign the new val-
ues, using a list {·,·,...} whenever
more than one value must be
set. 
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MATHEMATICA TUTORIAL 
(continued from page 26) 

The next few experiments use a different envelope for the sine wave: 
bellsin[x_] := Exp[-(x-2)^2] Sin[8 Pi x] 
Plot[bellsin[x], {x, 0, 4}, PlotRange->{-1, 1}] 

  

Plot[bellsin[x], {x, 0, 4}, PlotRange->{-1, 1}, Plotpoints->100] 
  

Plot[bellsin[x], {x, 0, 4}, PlotRange->{-1, 1}, PlotPoints->100] 
  

(continued on page 28) 
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Note that plot
seems  to have
blown it in three
places, where it
cut off at zero rath-
er than finding the
proper nadirs.
More plot points
are needed for
such a finely de-
tailed function. 

General::unkopt: 
 Option Plotpoints->100 is not known for Plot. 

I tried to specify this, but made one of
my most frequent errors:  It wants
"PlotPoints," not "Plotpoints." 
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Fortunately, this can be
quickly corrected with
mouse editing. 
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MATHEMATICA TUTORIAL 
(continued from page 27) 

A corresponding curve using the cosine can then be constructed by copy, paste, and changing "sin"
to "cos" in a couple of places: 
 
bellcos[x_] := Exp[-(x-2)^2 Cos [8 Pi x] 
Plot[bellcos[x], {x, 0, 4}, PlotRange->{-1, 1}, PlotPoints->100] 
  

Now for the fancy tricks.  You can actually give Mathematica a list of functions to plot as the first
argument and get them all overlaid on a single plot.  In this case, I included four functions in the
list, the recently defined bellsin, bellcos, plus the normal density envelope, and its vertical reflec-
tion: 
 
Plot[bellsin[x],bellcos[x],Exp[-(x-2)^2],-Exp[-(x-2)^2]}, 
{x,0,4}, PlotRange->{-1, 1}, PlotPoints->100] 
  

(continued on page 29) 
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MATHEMATICA TUTORIAL 
(continued from page 28) 

Until now, all of the plots have come out in the standard size set by Mathematica.  You can alter
the size of a plot dynamically by clicking the mouse inside the plotted area.  A box pops up around
the plot with little square blocks that serve as handles.  Mouse over to a convenient handle (often
at the lower right), and press down the mouse button.  While holding it down, drag the box out to
the desired size.  When you release the button, the graph will disappear temporarily, before it re-
appears in its rescaled form: 
 
In[9]:= 
Plot[bellsin[x],bellcos[x],Exp[-(x-2)^2],-Exp[-(x-2)^2]}, 
{x,0,4}, PlotRange->{-1, 1}, PlotPoints->100], AspectRatio->1, 
PlotLabel->”Bell curve bounded Sin+Cos waves”] 
  

 
Mathematica also does three dimensional plots.  The function then depends upon two variables,
(here "x," and "y"), and thus has two range specification lists ({x,0,4} and {y,0,4}), appearing as
the second and third arguments to Plot3D: 
 
In[9]:= 
bellsin2[x_] := Exp[-(x-2_^2] Sin[2 Pi x] 
 
In[15] := 
Plot3D[bellsin2[x],bellsin2[y], {x,0,4},{y,0,4}, 
PlotRange->{-1, 1}, PlotPoints->100] 
 
 
 
 
 
(continued on page 30) 

 

Bell curve bounded by Sin+Cos waves
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Two additional plot op-
tions were included here,
adjusting the aspect ratio of
the plot (making it square),
and adding a title. 
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MATHEMATICA TUTORIAL 
(continued from page 29) 

  

The Show function allows you to easily replay plots with modifications to the plotting parameters.
The selected options change the appearance of the plot quite substantially.  If you don't like Math-
ematica's default lighting, you can specify the light sources as well.  Here "%" refers to the previous
plot: 
 
In[16]:= 
Show[%, Lighting->True, Mesh->False, Boxed->False] 
 
 
 
 
 
 
(continued on page 31) 
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This plot has been enlarged
by dragging. It takes quite
some time to process, not a
surprise considering the
overall magnitude of the req-
uisite computations. 
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MATHEMATICA TUTORIAL 
(continued from page 30) 

  

The last example in this series replots the image from the previous page again, with the original
surface characteristics, but from a different viewing position: 
 
In[17]:= 

Show[%%, ViewPoint->{5,5,0.5}] 
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In this case, "%%" refers back to the plot before the one above - "%15" could have
been used instead. 
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The following is a partial listing of products for
the NeXT. This is not an official publication of
NeXT Computers, Inc. and no warranty, either
express or implied, is given. Up-to-date info is
always welcome. Copies for review are
encouraged. Reply to Chuck Herrick,
cnh5730@calvin.tamu.edu. 
 

ANALYTICAL 
  
Affinity Systems (316.636.5100):  
 Tactician Plus (multiuser spreadsheet) 
 Ashton-Tate (800.437.4329): 
  PowerStep (spreadsheet) 
 Informix (913.599.7100): 
  INFORMIX-TURBO (database engine  
  for OLTP) 
 Wingz (spreadsheet) 
  Ingres (800.446.4737):  
 RDBMS (database) 
  KnowledgeSet Corp (415.968.9888):  
 KRS (database search and retrieval) 
  Lotus (617.577.8500):  
 Improv (spreadsheet) 
  Microstat (604.228.1612):  
 OMEN III (investment information  
  retrieval and manipulation) 
  Oracle (800.345.3267):  
 RDBMS (database) 
  Professional Software (617.246.2425):  
 Objective DB Toolkit (30 classes link  
  NeXT to Sybase) 
  SAS (919.677.8000):  
 statistical analysis and presentation  
  software 
  Stone Design (505.345.4800):  
 DataPhile (database) 
  Sybase (800.879.2273):  
 SQL Server (database) 
  Triakis (505.672.3180):  
 DAN (data analysis and plot system) 

  Wolfram Research (217.398.0700):  
 Mathematica (mathematical analysis) 
 

PUBLISHING 
 
 Abaton (800.444.5321):  
 Scan 300/GS (scanner) 
  Adobe (415.961.4400):  
 Illustrator, Plus Pack, SmartArt 
  Altsys (214.680.2060):  
 Stealth (advanced drawing, graphic arts) 
  Canon (800.848.4123):  
 IX-30F Image Scanner (scanner) 
  Data Transforms (303.832.1501):  
 InDia (graphical decision-making) 
 GEMS (flexible modeling system,  
  ex: economics) 
  Epitome(615.675.0910):  
 Redline (multiple reviewer) 
  Flash Graphics (415.331.7700):  
 Flash Graphics (screen, slide, paper  
  presentations) 
  Font Company (602.998.9711): 
 extensive PostScript font library 
  Frame Technology (408.433.3311):  
 FrameMaker (desktop publishing  
  environment) 
  HSD (415.964.1400):  
 Scan-X (scanners, optical character  
  recognition software) 
  Innovated Data Design (415.680.6818): 
 Dreams (drawing and drafting) 
  Lighthouse Design (800.366.2279):  
 Diagram (graphical diagramming) 
  Media Logic (213.453.7744) 
 Artisan (paint and image processing  
  system) 
 TopDraw (drawing package) 
  Quark (303.934.2211):  
 QuarkXPress (publishing software) 
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  RightBrain Software (415.851.1785):  
 TouchType (typesetting; desktop  
  publishing) 
 Stone Design (505.345.4800):  
 Create, ArtDraw, TextArt (desktop  
  publishing) 
  T/Maker (we need a phone and address):  
 ClickArt (PostScript images library) 
  WordPerfect (801.225.5000):  
 WordPerfect 5.0 (word processor) 
 
 

CONNECTIVITY 
 
 
  Abaton (415.683.2870):  
 InterFaxNX (fax modem) 
  Active Ingredients (617.576.2000):  
 Communicae (VT220 and Tektronix  
  4010/4014 emulation) 
  Asante (408.734.4844):  
 TR/SC (NeXT (SCSI) to Token-Ring) 
  Atlantix (800.262.6526):  
 XWave (integration software, NeXT to  
  PC LANs) 
  AVATAR (508.435.3000):  
 InSession 3270 (IBM 3270 connectivity) 
  Cayman Systems (617.494.1999):  
 GatorBox, GatorMail, GatorShare  
  (NexT to Mac net) 
  Coconut Computing (La Jolla, CA;  
  brian@coconut.com): 
 COCONET (Unix-based BBS/ 
  conferencing program) 
  Conextions (508.475.5411):  
 3270Vision (IBM 3270 connectivity) 
  DataViz (203.268.0030):  
 MacLinkPlus/PC (NeXT to Mac file  
  transfers) 
  HSD (415.964.1400):  
 OCR (fax software-scanner) 
  Morning Star Technologies (800.451.1883):  
 Synchronous SCSI Communication  
  Interface 
  Novell (408.434.2300):  
 Novell NetWare integration software 

 Objective Software Engineering  
  (604.261.0186):  
 Mirage Fax (fax modem) 
  Software Ventures (415.644.3232):  
 MicroPhoneII, WatchMe, ScriptEditor  
  (telecommunications) 
  Touch Communications (408.374.2500):  
 Worldtalk/400 (X.400 messaging  
  gateways) 
  Transarc (412.338.4400):  
 AFS (distributed file system) 
 

COLOR 
 
  Analytical Graphics (215.337.3055):  
 STK (Satellite Tool Kit, satellite  
  planning) 
  HSD (415.964.1400):  
 Scan-X Color (color scanner) 
  Tektronix (503.221.1063):  
 Phaser PX (color printer, serial, parallel  
  and AppleTalk ports) 
  Oce (800.545.5445):  
 OceColor (PostScript printer) 
  QMS (415.363.4300):  
 ColorScript 100 (color PostScript  
  printers) 
 

GRAPHICS 
 
  Pencom Software (512.343.1111):  
 X windows X11R4 
  Ohio Supercomputer Center (614.292.0006,  
  michelle@osgp.osc.edu):  
 apE (visualization and image processing  
  package) 
 

SOUND 
 
  Univ. Virginia (uvaarpa.acc.virginia.edu):  
 CSound-NeXT v2.0 (digital synthesis  
  software interface) 
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MULTIMEDIA 

 
  Ariel (201.249.2900):  
 IRCAM (multi-RISC NeXTBus board  
  for vector/signal processing  
  engine) 
  Boss Logic (515.472.7740):  
 Boss BDMS (document management  
  software) 
  Coda Music Software (800.843.2066):  
 MusicProse (music notation software) 
  DisCopyLabs (415.651.5100):  
 software duplication services in 2.88 MB  
  format 
  Icarus Software (617.247.1350):  
 LiNK-IT (hypertext system) 
  Imagine, Inc (313.487.7117):  
 MediaStation, MediaBrowser  
  (multimedia database) 
 FirstChair (MIDI and sound sequencer) 
  Knowledge Transfer Intl (214.233.7693):  
 SimuLEARN (instructional multimedia  
  tool kit) 
  Metaresearch (503.238.5728):  
 Color Digital Eye (high-res. color frame  
  grabber) 
 Digital Eye, Digital Ears (gray-scale  
  frame, sound grabber) 
  NVT (415.285.8744):  
 High Density Video Drive (video  
  playback device) 
  Thoughtful Software (303.221.4596):  
 HyperCube (hypermedia environment) 
  Visus (412.687.3800):  
 Fax DEMON, PaperSight (fax, document  
  image management system) 
 

HARDWARE 
 
  Ariel (201.249.2900):  
 QuintProcessor (multiprocessor DSP  
  NeXTBus board) 
 DM-N Digital Microphone 
 

  Daewoo Telecom (508.836.4800):  
 Daewoo Graphics & Imaging System  
  (image processing board) 
  Dazzl (309.674.9317):  
 16/12 Analog to Digital Converter  
  (NeXTBus board) 
  DIT (505.662.1459):  
 CubeFloppy 2.9 (floppy, Mac file transfer  
  software) 
 CubeDigital I/O, SCSI488/N (NeXTBus  
  boards, controllers) 
  Extron Electronics (800.633.9876):  
 Extron Board (NeXTBus large screen  
  projector board) 
  IOtech (216.439.4091):  
 ADC488, DAC488 (A to D, D to A  
  converters) 
 Digital488/80, Serial488/4 (IEEE to  
  digital, IEEE to serial) 
 Driver488/N (IEEE488 Obj-C driver) 
  Pacific Microlectronics (800.628.3475):  
 PMHIDE (external SCSI hard disk drive  
  enclosure) 
  Pers. Comp. Periph (813.884.3092):  
 JETSTREAM Tape Backup (high- 
  performance tape backup) 
  PLI (800.288.8754):  
 SuperFloppy 2.8, Mach One (floppy,  
  high-speed hard disk drives) 
  Singular Solutions (818.792.9567):  
 A/D64X (analog-digital interface) 
 

 BUSINESS 
 
  Adamation (415.452.5252):  
 Live Wire, Who's Calling (business info  
  management) 
  Boss Logic (515.472.7740):  
 Contact! 1.0 (business contact database) 
  Chadwyck Healey (800.752.0515):  
 MundoCart/Optical (cartographic map  
  database) 
  DIT (505.662.1459):  
 OnDuty (office task management) 
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  Stained Glass Software (408.249.3337):  
 Calendoscope (appointment calendar  
  program) 
  TransGraphics Systems (415.283.5750):  
 TransManager (terminal management  
  software) 
 

PROGRAMMING LANGUAGES 
 
  Absoft (313.853.0050):  
 FORTRAN77 (with object oriented  
  extensions) 
  Acucobol (619.271.7097):  
 ACUCOBOL-85 (COBOL) 
  ana-systems (415.341.1768):  
 Modula-2 
  Franz Inc (415.548.3600):  
 AllegroCL (Common Lisp) 
  GNU (prep.ai.mit.edu):  
 C, C++ , Objective-C, Smalltalk 
  Interactive Software Engineering (Santa  
  Barbara, CA; eiffel.com):  
 Eiffel 
  Iverson Software Inc (416.925.6096):  
 J  
  Jefferson Software (602.234.3106):  
 Modula-2 
  Motorola (512.891.2030):  
 DSP 56000 Assembler 
  Oasys (617.890.7889):  
 C, FORTRAN, Pascal 
  Plus Five Computer Services (314.426.3900):  
 MUMPS 
  public domain: 
 FORTRAN-to-C converter (f2c.tar.Z in 
   /pub/next/sources at  
  cs.orst.edu) 
 Pascal-to-C converter  
  (csvax.cs.caltech.edu in 
   pub/p2c-1.18.tar.Z) 
 Prolog, forth (in development) 
 Standard ML (in pub/ml at princeton.edu) 
  Toltec Human Services (405.840.4254):  
 UNIX MUMPS 
  Univ. Va (804.982.2209):  
 Uvapc (Pascal) 

 
DEVELOPMENT 

 
  Adobe Systems (415.961.4400):  
 Displaytalk (PostScript development  
  environment) 
  Ariel (201.249.2900):  
 Bug-56 (DSP debugger) 
  ana-systems (415.341.1768):  
 Documenter's Workbench (troff, etc.) 
  By Design Technology (800.776.8649; email:  
  info@bydesign.com):  
 OO-Browser (multi-language object- 
  oriented class browser) 
  Information & Communications  
  (800.776.9966):  
 AKGH (context-sensitive on-line help  
  tool) 
  Lighthouse Design (800.366.2279):  
 Exploder (object-oriented database) 
 Schematic Entry (EE-CAD tool) 
  Motorola (512.891.2030):  
 SIM56000 (DSP simulator program) 
  Objective Technologies (212.227.6767):  
 [OT Palettes 1.0] (GUI object library/ 
  palette) 
  ONyX Systems (817.468.2695):  
 BugByte (graphic interactive symbolic  
  debugger) 
  Professional Software (617.246.2425):  
 Objective DB Toolkit (obj. library,  
  database support) 
  Informix (913.599.7100):  
 Math++ (C-language math library) 
  WeDesign Inc (415.479.1105):  
 TheLibrary (on-line help information  
  system) 
 

MEDICAL 
 
  BioMedical Design Group (612.645.9062):  
 BioTRACE 8 (real-time acquisition and  
  monitoring for animal  
  research) 
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  LMER (717.531.7589):  
 Gray's Anatomy-digital (digital version  
  of Gray's Anatomy) 
 
 Toltec Human Services (405.840.4254):  
 Transcriber (medical record transcription  
  tool) 
 

OTHER 
 
  Alva Computer (804.851.6830):  
 Airfoil Design Kit (aerodynamic  
  engineering tool) 
  Deltos Fleet Computing (214.540.2301):  
 GeoKit (object-toolkit for cartographic  
  map rendering) 
  Halchin and Fleming (217.348.0917): 
 Rubik Algebra (courseware) 
 Spring (differential equation modeling  
  program) 
 Taylor (Taylor polynomial software) 
  Insignia Solutions (408.522.7600):  
 SoftPC (IBM-PC/AT MS-DOS emulator) 
  LaSTLock (408.296.6550) 
 cable security system 
  Lighthouse Design (800.366.279):  
 First Compilation Disk (asst public  
  domain software) 
  NeXTConnection (800.800.6398)  
 (NeXT-specific mail order) 
  public domain:  
 iwf (ImageWriter II printer-driver)  
  (cs.orst.edu) 
 JumpBack (backup facility)  
  (sonata.cc.purdue.edu) 
 News (NeXTstep newsgroup news- 
  reader) (cs.orst.edu) 
  shareware: 
 iwscript (ImageWriter II printer-driver)  
  (sutro.sfsu.edu) 
 Stuart (full-featured NeXTstep VT100  
  terminal app) (cs.orst.edu) 
  Software Engineering Solutions  
  (512.343.2828): 
 AtTheBeep (NeXTstep message handling  
  system) 

  Uni-Kit (415.490.8911) 
 cable security system  
 

MAGAZINES AND 
NEWSLETTERS 

 
  BIX (800.227.2983):  
 NeXT special interest group 
  Boylan Enterprises (404.271.8305):  
 NeXUS Magazine: (NeXT oriented  
  magazine) 
  Baran's Tech Letter (208.265.5286,  
  nbaran@well.sf.ca.us)  
 (newsletter) 
  International Data Group (415.978.3182):  
  NeXTWORLD (magazine) 
 NeXT on Campus (subscribemail:  
  next_on_campus@next.com) 
  NeXT Users' Journal ( elec. magazine; in 
   /pub/next/buzzings 
   at cs.orst.edu) 
 Tao (newsletter, in /pub/next/tao at  
 nova.cc.purdue.edu) 
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